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Abstract 
      Bisphosphonate (BP) and geranylgeraniol (GGOH) are known drug/reagent affecting osteoblast 
shape and dimensions. Digital image analysis such as ImageJ can detect changes in cell 
dimensions. Commonly, fluorescence staining, a high-cost dye, is used for staining cells. Therefore, 
this study was attempted to investigate dimensional changes in cells stained with a simple and low-
cost dye and measured by ImageJ analysis.  
      Pre-osteoblast, MC3T3, cells were incubated with alendronate (ALN) and GGOH. Cells were 
stained with crystal violet and were recorded for quantitative measurements via ImageJ. The 
measurement procedure was defined to perform cell segmentation. Cell area, number, dimensions, 
and aspect ratio were measured. 
      Crystal violet staining method exhibited similar results to fluorescence staining method in terms 
of cell area and aspect ratio. ImageJ distinguished the changes in cell numbers and cell sizes after 
treating with ALN and GGOH. Furthermore, the result obtaining from the automated ImageJ method 
was comparable to that of the manual ImageJ method in terms of aspect ratio. 
      The staining and analyzing technique detected pre-osteoblast dimensional changes after ALN 
and GGOH treatments. It was practical and easy to use. It could be an alternative method for 
screening of cell changes after drug treatment.  
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 Introduction 
 

In biomedical study, there is a growing 
demand for a screening system that is simple, 
precise, capable of rapidly building data, and 
versatile for a variety of applications. Digital 
image analysis has been widely developed and is 
used in various biomedical applications because 
of its positive impact on altering qualitative data 
to quantitative data.1-4 One of the most commonly 
used digital analysis software is ImageJ. It is a 
reliable and free downloadable software with 
various functions.5  

An example of the drugs that is related to 
the dental field is BP. This drug is prescribed to 
prevent excessive bone resorption.6 However, it 
is found to relate to a condition called 
medication-related osteonecrosis of the jaw since 
2003.7-9 Therefore, the studies of BP are 
extensively examined.10-14 In order to screen and 
rapidly obtain data, in vitro cell culture-based 
screening test has been emerging in the 
pharmaceutical industry. This system can be 
performed rapidly and quantified high volume of 
information, which is later applied in in vivo and 
clinical tests.15 

In this study, we aimed to exploit a simple 
method to evaluate the changes in cell size and 
dimension. ALN (a nitrogen-containing BP) and 
GGOH were utilized since the drug/reagent are 
previously shown to alter cell morphology and 
cell size.2, 16 Crystal violet dye was used instead 
of high-priced fluorescence dye because it is a 
simple as well as economical staining technique 
and can be visualized under a regular light 
microscopy. The processing method of ImageJ 
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analysis was modified to investigate cell 
dimensional changes. By using this procedure, 
the changes of cells could promptly be identified. 
This would be a potential tool for predicting or 
screening responses of cells to drug treatment 
and/or other stimuli, which could be applied in 
cytopathology and in vitro studies. 
   

Materials and methods 
 

Murine osteoblast precursors, MC3T3 
cells were plated at a density of 8,000 cells/cm2 
in α-minimum essential medium (Gibco) 
containing 10% fetal bovine serum and 1% 
penicillin/streptomycin at 37°C and 5% CO2 
humidified atmosphere. MC3T3 cells were 
treated with ALN at 10 µM (A10) and GGOH at 
10, 50, and 100 µM (G10, G50, and G100) for 3 
days. Cell with no treatment (A0G0) served as a 
negative control and cell treated with 10 µM ALN 
(A10G0) served as a positive control. 

After 3-day incubation, cells were fixed 
with 4% paraformaldehyde for 15 minutes at 
room temperature. Fixed cells were stained with 
crystal violet (Life Science Dynamic Division, 
Arnaporn Co., LTD) for 5 min, and rinsed 
carefully. Cell appearance was examined under a 
light microscope (Nikon Eclipse TS100) at 200x 
magnification. Eight random fields from two wells 
were recorded using a Nikon Digital sight DS-L2. 
Nine to ninety cells were scored for each field. 
For quantitative analyses, ImageJ software 
version 1.52a Java 1.8.0 (National Institute of 
Health) was performed. The following parameters 
were analyzed: %area, cell number, cell size 
(area; μm2), cell length and width (µm), and 
aspect ratio. Rhodamine phalloidin staining was 
performed as described in Patntirapong, 2021.2 
This method served as a conventional staining 
method. 

The scale was first set using “Analyze > 
Set Scale” command. A micrometer unit was 
fixed by choosing the “Global” button in order that 
every image had equal scale for measurement. 
Original images were processed by two 
identifications: automated and manual detections. 
The background of images was optionally 
eliminated by picking the “Process > Subtract 
Background” function. This option flattened 
uneven background and allowed the processing 
of images with bright background and dark 
objects. Images were converted to grayscale by 
running “Image > Type > 8-bit”. The images were 

processed with “Image > Adjust > Auto 
Threshold” commands. “Huang” and 
“SetThreshold instead of Threshold” were picked.  
The focused area then displayed in red color. 
Because some cells attached on the well plate as 
clusters, the following functions were applied: 
“Process > Binary > Make Binary” and “Process 
> Binary > Watershed”. The objects of interest 
were changed to black objects over white 
background. The clustered cells were segmented 
from one another. By these steps, the identified 
cells were ready for analyzing. For automated 
detection, the parameters were characterized by 
“Analyze > Analyze Particles" function. It should 
be noted that the particles smaller than 200 µm2 
were excluded. For %area, "Analyze > Measure" 
function was selected instead of “Analyze 
Particles” function. 

For calculating the length and width of the 
cells, an extra step was applied. The “Straight” 
and then “Analyze > Measure” commands were 
used manually to measure major and minor axis 
of each single cell. Major/minor axis of each cell 
was later calculated for aspect ratio. 

Normality test was performed by Shapiro-
Wilk test using GraphPad Prism version 5 
(GraphPad software). Data were then analyzed 
by One-way analysis of variance followed by 
Dunnett multiple comparison test and unpaired t-
test. Data were expressed as means ± SD. 
Significance was assigned as *p < 0.05, **p < 
0.01, and ***p < 0.001 vs A0G0. Significance 
was assigned as ᶲp < 0.05, ᶲᶲp < 0.01, and ᶲᶲᶲp < 
0.001 vs A10G0.  
 

Results  
 
By visual inspection, cells in each 

treatment condition seemed to show different cell 
shapes, dimensions, and spreading. Cells were 
distributed on the well plate as clusters or a 
single cell. MC3T3 cells in untreated condition 
(A0G0) exhibited polygonal to cuboidal shapes. 
A10G0 cells demonstrated fusiform and round 
shapes. Addition of G50 and G100 to A10 cells 
were able to alter A10 cells to cuboidal shape. 
Cell shape in this condition appeared to be more 
homogeneity than in A0G0 and A10G0 (Figure 1).  

Next, the qualitative data were converted 
into quantitative data. The modified staining 
method (crystal violet) was initially compared to 
the conventional staining method (rhodamine 
phalloidin) using A0G0 condition. The workflow of 
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system analysis for crystal violet staining was 
shown in Figure 2A-F. The representative 
schemes for rhodamine phalloidin were 
presented in Figure 2G-H. The area per cell and 
aspect ratio (AR) of both staining were assessed. 
The measurements of crystal violet staining were 
comparable to those of rhodamine phalloidin 
staining [Figure 2I and J]. The average area per 
cell for rhodamine phalloidin and crystal violet 
was 789 ± 724 and 802 ± 554 µm2, respectively 
(Figure 2I). The average AR was 1.6 ± 0.45 for 
rhodamine phalloidin and 1.61 ± 0.46 for crystal 
violet (Figure 2J). The similarity of these data 
suggested the potential use of crystal violet. 

 

 
Figure 1. Crystal violet-stained images. MC3T3 
cells were treated with ALN and GGOH at 
different concentrations for 3 days. 
Representative images showed cells stained 
positive to crystal violet. The changes in cell 
morphology were monitored by light microscopy. 
Inset illustrated round-shaped cells from another 
view. Scale bar = 100 µm. 
 
 

We later applied crystal violet staining 
and an automated function of ImageJ method to 
cells treated with ALN and GGOH. The %area 
coverage, cell number, and cell size were 
determined. The %area coverage is quantified 
using an Area Fraction output of ImageJ in order 
to demonstrate cell growth.4, 17 The difference 
of %area was distinguished among groups. 
A0G0 covered the well area more than 40%. No 
significant difference was observed in the 
addition of GGOH. Cells subjected to treatments 
with A10 occupied less than 5% area. In the 
presence of GGOH, increases in the area 
coverage were monitored (Figure 3A). 
 

 
Figure 2. ImageJ processing and comparison 
between crystal violet and rhodamine phalloidin 
staining methods. The workflow of crystal violet-
stained cell segmentation was demonstrated as 
followed: (A) Original image was obtained. (B) 
The image background was subtracted. (C) The 
image was converted to grayscale. (D) 
Thresholding was applied to the image. (E) Each 
cell was segmented by watershed function. (F) 
ImageJ labeled each cell separately. The 
representative schemes of rhodamine phalloidin-
stained cells are presented in (G) Original image 
and (H) Thresholding image. (I) Area per cell 
graph. (J) Aspect ratio graph. RP; rhodamine 
phalloidin, CV; crystal violet, NS; not significant. 
 

The cell segmentation procedure could 
distinguish individual cells from background and 
the adjacent cells, despite these cells being 
assembled closely together (Figure 2E). The 
software was able to mark each single cell in the 
resulting images (Figure 2F), hence, granting an 
automatic cell count. A0G0 were approximately 
75 cells per field. A10G0 were significantly lost 
from the culture plate and had been estimated to 
be around 9 cells. The addition of G100 
increased the number of cells on the well surface 
(Figure 3B).  
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Figure 3. Calculation of pre-osteoblast cell area 
by automated procedure. (A) Area fraction. (B) 
Number of cells. (C) Area per cell (µm2). (D) 
Distribution of cell size. 
 

Figure 3C demonstrated the difference of 
average single cell spreading area. Calculation of 
the cell area showed a significant reduction of 
cell size in A10G0 group compared with A0G0. 
The addition of G50 and G100 to A10-treated 
cells markedly increased in cell size (Figure 3C). 
The cell size was later established in histogram 
to present the distribution of the area per cell 
(Figure 3D). In A0G0, the distribution frequency 
of cell area mostly fell into 500-1,000 µm 
followed by 200-500 µm range (Figure 3Di). The 
addition of G50 and G100 to A0 cells as well as 
A10 shifted the distribution of cells to a smaller 
size range (Figure 3Diii-Dv). Cells in the A10G0 
group mostly contain 200-500 µm size range with 
the frequency at around 35. Cell size larger than 
1,500 µm was not seen (Figure 3Dv). Cell size 
larger than 1,500 was speculated after GGOH 
treatment to A10 cells (Figure 3Dvi-Dviii). Cells in 
A10G100 treatment showed the equal 
distribution of cell size among the 200-500, 500-
1,000, and 1,000-1,500 µm range [Figure 3Dviii]. 

These results indicated an ability of the 
technique used in this study to characterize cells 
in different conditions.  
 

 
Figure 4. Estimation of cell dimensions. (A) After 
cell segmentation, length (red line) and width 
(blue line) were manually measured. (B) Length 
and width measured by manual procedure. (C) 
Quantification of aspect ratio calculated by 
automated and manual methods. 
 

Cell dimensions, length and width, were 
measured. The alteration could be assessed by 
manual and automated quantifications. The 
manual measurement had been done to assess 
the length and width of each cell (Figure 4A). 
Cells incubated with A10 were significantly 
smaller in length and width than A0 cells. 
A10G100 notably increased cell dimensions 
compared with A10G0 (Figure 4B). AR, which is 
major axis/minor axis, was calculated. AR 
determined manually was compared with AR 
calculated automatedly. No significant difference 
was observed between automated versus 
manual identifications (Figure 4C), verifying the 
comparability of the automated method to the 
manual method  
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Discussion 
 

ImageJ is now being used for various 
imaging applications, which can read most of the 
common formats used in the field of biomedical 
imaging.5 The examples of ImageJ use include 
examination of immunohistological staining, 
analysis of fluorescence staining, evaluation of 
mitochondrial network morphology, and 
interpretation of alizarin red and alkaline 
phosphatase staining, and etc.1-4 Here, we 
demonstrated another application of ImageJ that 
could be used in the research field using crystal 
violet staining.  

For morphometric analysis of cells, cell 
cytoskeleton is usually stained with fluorescence 
dye and cell size is examined using 
fluorescence/confocal microscopy.2, 18 By utilizing 
the fluorescence method, previous study reports 
the changes in osteoblast shape treated with 
ALN and GGOH.2 In this study, cell dimensional 
change was characterized by different staining 
system and a modified automated procedure. 
Crystal violet staining is a simple and affordable 
staining technique. It is one of the most common 
techniques used in staining adherent cells.11, 19 
The dye binds to proteins and DNA in cells20, 
marking cell boundary and cell morphology. 
Although this staining technique is not new, 
however, to our knowledge application of this dye 
to pre-osteoblast together with utilizing 
automated ImageJ analysis has not been 
performed. The finding showed that cells stained 
with crystal violet dye could be successfully 
segmented and quantified by ImageJ. The 
technique described in this study was able to 
convert qualitative to quantitative data. The 
changes in cell size after ALN and GGOH 
treatments also demonstrated the same trend as 
reported by Patntirapong, 20212, implying the 
practicality of this modified method. This 
technique could be applied for screening cell 
dimensions and growth under various drug 
conditions. 

The ImageJ software distinguished the 
crystal violet staining from the background. The 
watershed function segmented the clustered cells 
separating one cell from another cell, resulting in 
the ability to detect a single cell area. However, 
there is a limitation using the software. The 
automated threshold function requires a fair 
quality image for analysis. In case of low-quality 
image, the contrast and brightness functions can 

be pre-processed to make the cells more 
distinguishable from the background before 
threshold function is applied.21   

Manual identification method is widely 
accepted in biological and medical image 
analysis. Nonetheless, the method requires 
strenuous task to obtain the data compared to 
automated measurement. The automated 
method can analyze a quantity of images with 
less time for researchers.21 Furthermore, this 
procedure is more scientifically objective method 
than manual image analysis and can be 
reproduced22, thus avoiding inter-observer 
variability. With an easily understandable 
procedure and advantage, this modified method 
could be used as an alternative option in the 
research field to obtain data.  
 

Conclusions 
  

The modified method, crystal violet 
staining and an adapted ImageJ procedure, 
could detect the changes in pre-osteoblast 
dimensions after ALN and GGOH treatments. 
This method is easy to function and can analyze 
a number of images without script writing to 
execute the program. This method might be 
useful for other applications in the field of biology 
and medical sciences, e.g. screening of cell 
morphological changes after drug treatment. 
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